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Minimum system requirements
Adobe Director 11 for Windows

Intel Pentium IV 600MHz or higher

Microsoft® Windows® XP Service Pack 2 or later or Microsoft Windows
Vista

Microsoft Internet Explorer 6.0 or later

512 MB of RAM

500 MB of available hard-disk space (additional free space required during
installation)

DVD-ROM drive

Microsoft® Speech Application Programming Interface (SAPI) 4.0 or later
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Learn In English

Using the Score

Like the Stage, the Score provides a view of your movie. The Stage provides
a graphical view. The Score provides a view of the movie’s timeline. The Stage
displays the point in time that is selected within the Score.

The Score organizes and controls a movie’s content over time in rows called
channels. The Score includes many Sprite channels for the movie’s sprites. Sprite
channels are numbered and control when sprites appear in the movie. Additionally,
the Score includes effects channels that control the movie’s tempo, sound, color
palettes, transitions, and scripted behaviors.
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Learn In English

Using gradients

Director can create gradients in the Paint window. You can use gradients with
the Brush tool, the Bucket tool, the Text tool, or any of the filled shape tools.
Typically, a gradient consists of a foreground color at one side (or the center) of
an image and another color, the destination color, at the other side (or outside
edge) of the image. Between the foreground and destination colors, Director cre-
ates a blend of the two colors.

Yo



w

Hecd QMMS‘? PSS IRST
axi 4l oy
Angle sl
Component 33
Curve )
Cycle il -
Darken o
Depth Bos
Ellipse e
Fill »
Flip an 3
Glass D
Gradient e
Handle 0 S
Lasso S
Lighten 9
Magnify OO Sugli (0 Sy
Maintain 00 slhwiy
Marquee N ESHPRYREN
Perspective Sled dx 4w
Quality LbeS
Rotate =g
Skew oS

\td



Bitmar S Uiy

AP 2G5 omading
Solid e
Source oo
Spread 05 piie
Sprite b Sy 5l Ssb S
- Stroke N ]
Switch bol>
Trace oo Juis
Transform JSo s
Warp ool g

\A4



A HEE

= 05 AV il 557

‘glo}T 395

Soguds oo oolaiwl ool ax 51 LuSy g 5,10 polic byl gl ,955 plo o -Y
ol 60,5 a4z 5 G (Pattern) oI -V

oslawl (Gradiant) il G slxl sl p lei oo ) iz STas 51 Lol o iy jo -F

AN
19903
faudd 78 pabue sk |y Bitmap pglai (gjlwes pid alises syl -0 -
fads 7,25 1) Vector 6,0y )0 o8 15l slos )5 -
§wuu> Flash Component -V

Sl 5 ler S
fowlxS jo 2,8 i Oyt palal Cod aladi -)
55 50 (U
G oo YU oS (0
0)‘.5 ).15..4.’ &9.: 4 (silw.a @®
S oo oolatwl aiy ;5 olas’;I Cast Member G 51 o301 S olo| (6l -Y
Pattern Setting (&l
Tile Setting (&
Gradiant Setting (z
Select Pattern (s
fapo oo ploul Jas ax Loli5 o oty Iyl lgs jo Skew i 55-v
olgzds asgly b yails > (Al

05 hle (¢
et 59,5 05 (2
LSS, 50,5 wsSae (o
Fogus oo oalazwl VBCIOT 0 ey jo I3l plas 5l e S0 G (B lo KO s > -F
Stroke Color (& Background Color (.l
Fill Type (o Color Fill (z

YA



4

S A

Al a5t IS5 Pomalbss =

- £

Sl AT a1 00l Sy ol (39, (e o 0

58S pls S5l g 48 9940 Ellipse I3l 51 soliwl (il
Paint 0 oy )| oolazwl (&
o IS 0,8 9y (7
Vector o,y 5l eoliiwl (o

fa,ls 1,8 Property Inspector «bj plas™ jo yolai (s3lwes pid Slagdas -#
- Cast (w Member (|
Bitmap (s Movie (z
IPOEL G 5-300) - Sl 5l sl p pmalas jo ils Ky S Jlos! gz -V
Fill Color (& Gradiant (!
Stroke Width (s Fill Type (z
Sols ploeil g3 o |y Jae plas” Pen Il -A
il e bl 0,5 wdlal (o 0,5 bul> (Al
e S (0 e S e 5 (7
faialas’ )555 uls (Lol )l aea 2aled (6l (5,98 slaads -4
Ctrl+5 (o Ctrl+7 (!
Ctrl+T(s Ctrl + Shift+V(z
S s ol jorey ......a S 51 Magnifying Glass 1511 b sled o585 cg -V e
W""SL_S‘Q oolazwl
Ctrl(w Alt (&
space bar(s Shift (z
11-Which tools can use gradiant colors in paint window?
a) Brush b) Bucket
c) Text d)ABandC

Sldily Wiz o5yl

aS YL pgal @‘,Jo&.e‘.?:@w‘))wf\)bVector o,y dawgi 1) 5y JBl =)
e 1 oS e So g 48,5 S5 Pen lnl 5l asas (L) (owgin go0 2
ol iy 33 03303 3 IS5 e (g Szl 3 1T o Sy g oS
.E.wy w)y wb&m&d&mébg‘ 6‘).’45..\4‘0@ .)L’?u‘ o).:b‘)iuﬁ.uﬁ .E_wy
(05 adlsl o pls (g9, shol bl lawg )0 alais e Pen

va



.-: L o
- --1

=a= SR B7/E EAVEY IS5 LI ST

- :'illlr:L: |f'||.|'.:' %]

T . ]
= b a8 | Wi,

Vector o jzi bwyi >1,b V-Fo S

Sy sk S (b Gl Jsl Lo liselizals sl o2k Goig0T ool aslyy S =Y

Jlo plaie 4z gleaal)) wuS Lo JISCS! 51 a3Y olaws SaS a1, Ve b Y oloel pogae

ookl wlos,S slwl (510 b g ild 0y Jawgh a5 jigai O ol 510 sae sl
(0S8 ooliiwl Ll 5l g3 ojgel 5l als o SO 4o g ausS



cyo byl oble

GILS Slddse
139 )50 JBDI g2 i jl Jad ol gLk 4o
S8 138 1 oo sl aliho gla jvgy o
23S JgiS s 3 lg | lgsT oy Ll o slo ol elgsl b o
1 1g5T g Sl | ulagyio 1 81 g5 GIS1S sl Sl g jloslaiwl b
Ao g8 oazn g
23S Jusws Bitmap oo 1 lgeT 05,8 gaiuedl | lygyio o

23S 68Lal 059 00 | jLo > g0 slaciugd silgiy e



o ALo

5 el il iz SVgame 3 yate o3 )8 S e 0 s S
G 8l 5 S a8 el oY Gl S Gl IS8 5 Co ) ) el w il e
e ly Ggie Galng 5 BB S Y Gl B alds )5 4y )5S b asiles glaile jais
Sy 42 35 00,231, il 00,5 sl il B cslasto el 18 33005 ol
QS ABlal 0g3 059 s 1y ygte j0 0o oolaiul slacigd wles oo Lo aig—i (5 I35 )L
S LB A 5oy 2B Lad oy gdi dxlge Cigh SgeaS JSialy sislas sLiil wlSin s (Embed)
gyl o97gas |y (slofzg slaoslr 5.03,5 eslin] (y5%e (59, 52 i3z wlo (3lirdingd

0998 L a5 el (g aw 03l (5o RS 988 0l0 38 4 jasie slac LG |
(338 )0y odle 0,8 0 1 sl <l SV game Glsice o] A gam A sla )L,
5o T o El 3 Ll 5 55 e oIS 5 (shlo 555 o
@)y O 595 posle SUlS (andS (Ll g gt (gzmen (SISt Slles
S,S adlsl slailu,y sz slroje
AL ANCLET PR o

o le a8 015 0525 5555 nls )0 e sl eslatul (gl g, 90 (IS sk

e ol 5l esle] e gl s 9,5 5l -

155 s A5l sl 5l esliiul b e ags -Y

3,5 wulys Ll ,giS bl o e 5l ooliiuwl 0gou g g, oyl b1, Les anlsl ;o Lo
T M e oo 3l -F-1-)

O Nlgl a S e ul 6515800 5 o 5l e sl L8 0,5 5y 4.3.)0[_.‘5 =S plo
L ou— (gu—uJB o rtf (Rich text format) ool o —ie dxt (ASCii) 8 a1,
S yie wilgs cod Lol ol oo ciS 0,53 g o8 html (hyper text markup language)
ol @8y @l onlply S o )ly gole > (o 1) ow )8 )b aile o 4y <ol Unicode
1S oolaiwl ) Gl ST | canl g i

N SSs

Cast (9,0 4 Lagd Psd bls (0,5 5)l5 5 lagd sl ooliiwl b (o)l e 0y
bl sl L 190 b gl siile _abbogly dudlys g &5 o lgie aiile obgS yge (sl

(el B9y 2y

AY



@ mSe 50,5 3,lg g Snagit L o 51 185w Se g Word |l581s 5 5o (o s
SelgZi | 0l g Cigd Joud 5l (SMShe K03 wosgy clio 3L (5o 1) ialed (390

(osls

tsme sl L 0,5 0 g alKin g 4S5 B

32 0ad (g B e den (xS o aSasS cBa it gla LB 0,5 ol e ) 4SS
.Mé‘so u.u.:Lou |) w0 03 C)é )JSL»AJ asle Lsé)‘yo

5(N1-h6) Lo lgie aile sl o Lol slaSs html gla 18 51 oolaiwl ol8n of 4355

2S5 Ll (55,045 Jolaz o) aigd o ools ioled ol olwlid Jolo> o>

Oz INPUL g FOrm oo o8 olon] Glo S L (—w 50 sl ) IMg als
DS o,k o LTl eslas ausess | (Applet) laedl 4 (Frame) laols

Omets Sz |y Select Format (glojgloe jolS 198 plotxt Jl8 G 40,57 0 lg pln oI iS5
a0 oo iulad TV S Gillae (0,5 5 )5 £

Select Formal

[ Same Format For Remaining Files

F-1 o

AY



oloul e 5l oslaswl Gl g oauls Cast jo Jio paie K ol cely Jgl 4y 38
Sgu g0 Slow! Cast o Script G aS bl |y pgo 4 35 asslin wes oo |y ons
Slely bl g ety las 3l 2,5 50 1) 65ud &l jgiws ailgs oo 00 &)le 4
(3 ogles Lol pian Lad jo oK g g ,Sul L) 0sS 9,19 soliiul
M e 50,5 5)ls Y Jlo
iales 8505 1T c0s S slowl WOKD o oo (gaincdB (e SO mplem oo Jlo ol yo
S b 1y 2y dole crlple oS

a8 =11y Word 1581 5 -
DS B g o0 )5 ol ) 5 ke =Y -

Director Features
Director is a multimedia authoring software
It is support 8 channel of sound Mixing,
Import photoshop document,Mp3 sound files and rtf format.

Save as yisu | g Save slo,glxe HolS jo 1 glesnly) S o3 1t & ygmy 1) BB -Y
(9,5 ks o Docl 1) LB sl 5 w33 5 1) Rich text formata, ;3 Type

g Cast o)lg b oS Import 1, L oo 555 pls o,lg -F

Bl w00 )1y ke ol g S 09 00ld ioles b ousS dises o)y |yl oygx8T-0
(F-Y JSi) 09 5L Text o,mn ,0 B oS SIS bls Cast o o)1 59, 5

o 2yly o talyeg PV S

AY



2855 p18 J15 (sl 5l pl 3l ol b cyo s gi-F-1-Y
53 0 )lee a8 0uS ol ) 093 e wlel o eaS o 40 ould il g0 SIS Ay
(Text WINdow) v (il yg g dudgs o,x =)
(Text) ;g5 plo il dx 10 9990 yie Il =Y

(Text Window) ¢yis o iy 55 opie sloyl —F-1-¥-)
305 Sl ST S olsiige o b o wilga JolS Ky Sy oty ol
Gk 3l b oS SUST 1l lgs 5l Text WIindow aaS's (g9, 0 io,m ol sLax! gl p
gl F-Y IS gillae ol o, b ouss 35, |, Window & Text (Ctrl +6) g

Text o pziy J$o -V S

Text Window o e S5 ol :Y Jlw

bl Cast o iy 5,5 51,8 1 50 00 ol e dunlgs o a5 JIB Sl -)
S

BuiS Lol ) e 0 yzis Y

e Ol oS eslaiul g8 pls lnl a5l e S5 et S el 51 ST
Foreground (s,  yie 955 5, sl o Background Color g, aie; S5, 5l aS
DS Gl 1y 095 i 0550 S 00,5 SIS Color

AD



U5 258 00T e o8 il b e el 5l ST S Gl ol o ) 955 e -
50 el asie 0 Siws b 1) il o o] Cast Member 5,e S0 & jle &0 b e
e s Yl JS

5o g Cast o iy yo e Cast Member G sy ol 4 again 1) e 0 iy (9a51-0
D oo Szl ol bl Jglu

ol dbm !l (g0 9 S w9y —F-1-V-)
3905 Glalpg 1y e Olgiee BP9y 99 @
Text o ey 5l oolaiwl b Jgl g, ©

e 0,20 5o LAl 0590 yie B audS SIS [Lgo Cast o,y (o 0ol ol (v (59, )
STl

259050 bl Al s 0,5 S0 awgs 1) e =Y

bl ¥ JS0) 0usS ral s TeXt o ey (s dB il g L1y e 09—S1-Y
(oo oo lis 1y o Ji

1955 plo Il dxz )0 59290 FOreground Color asS's (59, o cyie ) s 51, -F
AsS Ol |y 095 a5 0550 K5 00,5 SIS

i |y e 0yt SIS LG 1 e -0

Foid Shybe FomSize  Line Spacing Ahprament
i “le uf= *HI Itl-:“ o

Lk iy Al afladd LajsTls alusli

s JB s F-F JSo

:Text Inspector o >y 5l oolatwl bipgo g, @

f)al.gw5oo;x_i,,lf)l.;soOTds)ﬁwU).qﬁ}fﬁbw)oo?yw
(F-0 JS&8) oS ol 1)31 Oy

Amiio 43 970 o la g F-0 Jb

%



JUUE SN R W S

. ).‘

7 3 S
% Dewign HTect upactr IR i 55 |, Window = Text Inspector (Ctrl+T)
s win ¥ (F-5 Js%)
B/U E==mnm
ble 2 W
TR 3
Fl Hypealinike s Text Inspector o yzis -5 Ji

Oled 0,y ;0 0290 sLd Il asS o adasde F-F ISl 0 a5 jelailen
Jad ol 8 el o aS s Text o oy (o Bl g 0 39290 sl |3
a5 3,00 3929 0 i oyl Ho HyperLink sl 4 asox olS S Lasd wpoi LsT T L
ST 05— oo ooliiwl (&5 40 dmin S wyo) URL G 4 Link ol jelaie 4y
Saman gl Hol5 ol jo 1y 095 1185 8560 URL s 00,5 il dis po ) e
o HyperLink coll> 4 1) sais Gl cyie 938 pls (WWw.google.com o)
Lol ool lzs 1) el cpl BV S 0,9 oo

| Deson m Tt upectr W
el M
B I U EE 3N
I g -

i | e e e

HyperLink ;o slxy| F-V <o

) ‘o.\.oeb.ﬁv

Cowd) S5 o0 25 o) JS— ta20 1,8 oa sl HyperLink g, 1, wgle 31
g ol S pioles D> Lagd ol 5wl ses  Blas] Qo;&lfbulfgo)ul Je e
Ol b 5l aS s g 9] 05T oS sl p3Y 0 Jasie URL a4y Lidly asisl 6l 5
O L ptae Jad 1o a5 o,ls 0929 URL a4 Jlas! gl 55 ool g, g ol o oS
Bitmap 4 s o Jeof -F-1-Y

ool asS bows (Bitmap) LSy Sl a1 955 pls 10 99290 (ygie Suiles oo Lo

WS Coly dien gl il suid cual ol o Ll oolazwl 550

AY



5 ol Joo

e 98 Sy 5 b ] (6l) 0 il Cast ooy o I, 955 e gLl
(8 S S ctrl g shift laal S 51 oiles o

O HSal cwdle o5 5l & .ou 35 |, Modify — Convert to Bitmap agis |
(F-A JSo) 2l oo jo (oolss el

s hguad ol -

HRrmap

F-A JSi

Ao 10 395 a0 (yw Do gas pati-F-1-¥

o,z I Text asil; o ol ologas Olg—d o0 dizmo (O e yolo Bl ey
03,5 Cawly SIS cdioms )0 39290 (yie (69, CwedlS 3500 (s Property Inspector
Qg TeXt aib; o,lg b aus 35 0 |, Cast member properties o ;5

I e il alh e
P

B Ep s H-laﬁ.dhn B, ey avny
Ll Sl s— T E‘H‘rm.—-"'-'

Tabbuglage #s———[Js, [ors—_3 oy
s il st """""'“"ﬂ’*“-a._‘_\ Diract To Stage

S pdilal s

e Hyperlink

Text 4l Slakis F-9 o

M



Text &by gbai 355,
Oyg0d |y e gl a5 ol o0 3D Mode s Normal sl aas, ;5 6l ls :Display
sns o sl JolS £ & o33ls3 b 130058 o (g s [T (a9 5 (SJymns
(S p punlgs
T 4 4035 d s gl)ld 5 WS o pend Giuled cg 1) e LB g4 :Framing
:C«w‘ﬁ}
Jed Wrap axiliz ool asls Warp sbias ¢ ,550 435 4 a8 ol :Adjust to Fit -\
Bl o ead ol Blal gl oS IS ail mSTO ply e QB o ye g 0l
3 o il JudWrap 51.a.a8 ol 1, G 6 e aSol S 09y dinlgze ovnlive
Sz SIT L) 09l oo Jate waz Sla 4y )093 jebay LAl e gl law ol
oo o TV IS0 50 (5 5kaw
TR Ve o S s s

Jd e e o el Cons o

axt 'l.t..frap ext .w'm SlalS) sl oo sl | Wrap o g
s Enable. JB cenly G %0 o IS Enable

(Cons 0olie

Him b @ B odd dh Wrap 4 ;8 5,05 F-1 « S

Iy olew LB 0B S Scrolling -
DS ol | aslgs se olgzds olasl 4y
Sl Sk b lp anss ol
olin o oS 2l 5 e
Y B oolael VY SSG o).l
(loas o,y ole sl jg, lgreds

= Wl LT

L]
Aiss W0 & o Scrolling iulei > F-1 1 S5

A



G095 (yie S b S olse e (gl olgsds ol 4y QB S adles oo Fixed -Y

Hobds e B Adjustto Fit o a5 el ol Jol ain 33 L a8l coglas asSs g |,

ails olgzds ojlasl ay S8 ailgs co FiXed al g 45 Lol 093 oo Sgazma (v 4y S0e>
(FY o) ot

Fixed Lilsi cdl> F-1 ¥ S

) dizxo 10 8g—>g0 e Wlgi o )5 asS Jlad |, a8 ) S1:Editable
S Sl

251 gyl aiz o, S aaalss o Sl ot o L5 VL o a5 shiles Wrap
DS Jled 1y a5 ol ol

555 I8 eodle b saylos,S sl 1,5 slyr Gialyes B lagyie a5 > 45 Tab
S S o e (g9, dulS Ao o Tab aaSo b algs oo 4y oyl

50 6550 Solynl e S b |yl axili> 5 ool Direct to stage caasw :DTS
Sz 0,5 o0 LBVL )0 e ainan) 0,5 )18 Jai 0550 (1o (59, Wilgi god dino
(il 4l )13 5emly Sl el JBIS o

IS 0o pas LNk 1 (6l aST 1) e iuled o926 :Use Hyper text Styles
Pyl das g ol gole Il j0 (yie) OB o S g oo Hhles 1B ,F 59,0 j0 4T
(oo 5 50,8 S5) @ 098 BB o Link &5 5,90

(Embed) 039 5 4 odgd o 5 4dlol -F-1-0

Giales & 1) e polie s oa s aslinul glacisd wns oo el L &) cublB ol
O il oo cnai Lot FgnalS 50 lacigd (ol 1090 (nl )5 0 adlal g
Al dalg> ool iuled  cwjod

S gio don 10 g Wg—i 0 (5l Cast ;o s olie &jgo 4 00l adlol slacisd
5wy s BB Gioled o8 4y La e

Qe



‘)U oY)

&loygle ;o5 B o 35 5 1, Insert > Media Element - Font a_ ;5 Lagio 51 -)
D9 5L FY S @llae ]

[ [T —— SRS T . |
W CogralFaet  Tipm - ki gahal E
ol Ferd P - l\\“\,.,
AaBé0cDAS - = mas (I

et W it o b sy ey (0 il
Caml aalad gy T

P i L Wit

HM

L_H—-lun--ﬂ!--u |

e |

i ik i ) [ e
kel b gy ks milail
1] Pl Bt _ ' |
Clmyd 4 ailidh

Cigd 99,5 LSl sl pgloe yolS F-1 1 S

AL b a5 0 1) 065 piacew 0 00 il sloigd I S Original Font iz 51-Y
Sl ob (pl 09—l jolls ol bzl o # o )i G ol o 4 New Font ,ol5™ ;o o

Lol elsds a4 sl s 5 95800 jalls ;555 pls Cigh 4 gy je slagio solai yo a5

Select the character setSto lgic b a5 (glogloee HolS" sl il y o e 51V
Lowis 999 o0 }mUé (QT LSLQA.CW 23 u.zss 6&%)5.&‘ S cons R add
Gy oS alol ol ow cnd 1) 2658 08 gl Gl Az g b aules e
oS S SIS << 4aS (59, b 00,5 S lgs ()T (59, CendlS 05 4SS
WS 1S 1) Cigd slracsesme ) ey G Cannd 315> aeS
Ll agee 5 Wig—ds oo 9, LaIN Wig iy b oS pldacsorme s 5l Cl iy 0S5
aile mlbracgosme 5l 5110 5 o a8 oolaiwl a_ib e Latin Characters
HB e S oolaiwl sl oo Rightto left sla L 4 Ly o 5 Arabic

Slogine j0 coai Cast ol ool adlol Cigd b auS ol 1) glojglxe jolS LG jo -F
I, Cast ;o oo adlol cigd aw F-1F JSC8) 09— ol cugd sl 4y by o

9



0590 o ddlsl slociss F- ) F JCo -

alol a5 placigd 5l Ll gancdB gl s S olxl |y 0g 5 slagyie fye—ST-0
ez |, Wide Latin sls oo Embed cogd aiges G F-10 S .0uS oolaiwl cylos S
W oo olid e (g B

oy Embed Ciss bussi o (sl F-10 Y

ay



Al 4055

Sl as sl 457 0l0 9929 5935 plo yo (ke sl eoliil (sl 29) 99 (IS H9boas

C)b )‘ oslol ) LQLQ'L’b Qo; .5)19 -\

5555 plo (s slalil 5l eolasul b e adgi ¥

ool e (TXE (ASCIl) (glgio,d Lo i lebld 0,5 o lg ay ol jouS plo
Js & html (hypertext markup language) L ouis souJB e rtf (Rich text format)
A5 0 lg 1y s B b aiile > 4y el Unicode (glpaco wlgs g Lol callily oo g

22,5 slml 1) e Glgices 25 1l 90 S5

(Text WINdow)  yie (il yg g dudgs o,ox =)

(Text) 55 pls Il de> 10 35250 (yie Il =¥

3905 Ghalpg 1) (e Olgicee B9 99 &

350 cyio U auS SIS 5lgd Cast o,oxy ) 0l 3wl e (59 CumdlS (Text ooy jl oolitwl b
S el 1) oo 0500 ol g cdB Il S8 s s 098 5l (ke w0 xiy > s

CaunnsdlS )iy 35 39 |y Ao j0 39390 (yio Il sl p5¥:Text Inspector o oy jl edlaiwl b
2555 1> ol (g9 5l a5 0 QB! )l (9,5 S0 b o 03,8 SIS ) Lg o s
35 0 1, Window-> Text Inspector (Ctrl+T)

Sy o 1,555 s 3 39250 550 (0 Comvert to Bitmap sy S o
2,S s (Bitmap)

Property o,5wy jl Text a5l 3 15T Sluogad oy g0 aiomo 1 e o3I )3 5 ey
gl yesd Inspector

oinles a1y 5L 3)90 (sleiisd g5 o Insert = Media Element = Font le )8 <SS 4
2,8 aslsl
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Text

Director provides many ways to add text to a movie. You can either create
new text cast members within Director or import text from an outside source such
as a document stored on the Internet. You can import plain text, RTF, or HTML
documents. After text is part of your movie, you can format the text in a variety of
ways by using the Director formatting tools. Director offers standard professional
formatting functions, including alignment, tabs, kerning, spacing, subscripts, su-
perscripts, color, and so on. You can also create hypertext links for any text.
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Learn In English

Sprites

A sprite is an object that controls when, where, and how cast members appear
in an Adobe Director movie. Multiple sprites can use the same cast member. You
can also switch cast members assigned to a sprite as the movie plays. Use the
Stage to control where a sprite appears, and use the Score to control when it ap-
pears in your movie.

Sprites appear on the Stage layered according to the channel in which they
are assigned in the Score. Sprites in higher-numbered channels appear in front of
sprites in lower-numbered channels. A movie can include as many as 1000 sprite
channels. Use the Movie tab of the Property inspector to control the number of
channels.

\y



Attached

Blend
Coordinates
Exchange
Extended
Ink

Matte
Offset
Overlay
Overwrite
Trail
Truncate

Tweak

NUWES

0055 S el
Slaizsee

ol

a8l Axwgs

25

M g 5 )9S
sl

SIS sl

P9,

Lo allss

0955 obsS

Ol askad SG Gaged (e 5 o s

Yy



)Lw)b &A;)S U)b’

; w

:@“lano,é-

A2 7l Sagel oloul 1) lacyl pul (lgs g0 yog, wiz a4 =)
0,5 oo |y, JUIS G [0 09290 (sloin] sl S (g5 o 459> -
¢z Sprite Overlay -0

S14 5 slezr S
DS oss |y Colyl S Member g o a5 plas S8 o -
change (!
Exchange (<
Swap (z
Exchange Cast Member (>

BL 1y an 38 el pud Hiled sy g0ty |y gy wl codle b 50 aS0) (gl )y Y

9,5 bl
Ink (e Name (I
Location (> Blend (z
§3,1 3,3,l8" WIS daas 4aS> plS" Stage (o syl Gl cgs Y
Ctrl (& Shift (I
Shift+Alt (> Alt (¢

Gkl w03, Jed |y Score o >y Ll Sprite Toolbar I3l jlgi 4y (o yiwd (gl =¥

View->Sprite Toolbar (.l
Window-> Sprite Toolbar (o
Modify->Sprite->Toolbar (g

View->Toolbars—> Sprite (>

§33)5 (50 Cal ol die Sl oSy 4l 0 Blad sl o 5ymen slaogls I SealuS -0
Darken (o Lighten (4l
Matte (> Background Transparent (z

VyY¥



Samd o Hlis |y Stage oYU a4l & Cuns ¢ dai (g350 dlold a5 plas’ —F
T (& B (wl
Y (o X (z

oS 30 ) L Canoguas 51V
Sg g0 0by Calpnl glas )| (!
Syden o5 Selpul oy (0
Sydss by Sulpnl (250 (2

Dy go 03wl i Copogas 5l ol el S 281 0,5 A )8 (6l A
Flip Horizontal (.|
Flip Vertical (o
Skew(z
Rortate(s

B adans o 1y Col el SLal slaps 18 col sl S 90,5 Paste slln 435 plas’ -4
$0,.5 sl J& slad jo
Overwrite Existing Sprites (!
Truncate Sprites Being Pasted (o
Insert Blank Frames To Make Room (z

Tow e
faro oo suled ) Cul sl Gleogas 51 Swlas” Sprite Overlay Sl -V«
3,lge doar (o Codlads g ;09> ogl> (z
Colywl €8 > Can oS 3)ly 1) 20 5-10 dlael 55 & Tweak o>y (sLa S j5, 51V
NG P
Cusl) = ol (< G = Y ()
Casly =YL (3 - onble
SakolsS” oyl (12,8 e (5568 (slaadS —\Y
Shift+j (<l
Ctrl+j (u

Ctrl+Shift+j (z
Alt+Shift+j (>

AR A



- _ :- : .slw)lg &A})S U')’
o & &@QMMQ?@M%@'

13- Sprites in lower-numbered channels appear in ...... of sprites in higher-
numbered channels.
a) Behind b) Front
c) Left d) Right
Sldily Wiz o5yl

Loy Sy |y paead O ol (ylgie ioled 5y oS asS =1 b Slideshow S -
A0 u..;l.o; 3% 6&091.?
220 yiles sl ol ol oo 4y 1) Fgals 158 s Slakad a5 0sS b iules -

(59,5 welass 4l O askad o isled lo ) m

VY5



GIld slgdse

13950 JBDI g2 i jl Juad il bl 4>

3 2 b |y o] elgsl sl Jguol

a3 pll |yyT Slauhis 0548 sulgs 1 (Tweening) lobio ¢pbueus!

8bog 181 g5 33 1 1gsT Slaul 0925 031> 25 |y o248 60 48 —iliross]
s pll Sloc

o0 1 ol Mz 3lgily 0348 20 yini T 33018 ol jas og | Pl 6dl>
DS gk |yl Sl g 338 Josas plid odls

J—os 5> gl g 3ol 1y 63 bwud Gy o el Sl Jgol
-34S (5 jlwosly



war Sl ) s slaglailn ) wie colw el ) ogdle (o35 pls Ll580e 58
bale; 5l S baendl .csl 00,5 wal )8 545 (515810 5 laos jo 55 |y baasle, ol
2B &S g b bl 05y il LSLQ’J’;) 4,55 s 5o T adg Sl a8 el
S8 ooliitul 5 )90 abogy o (slaslw; wiz 55 ol Glad 5 )90 (r—tuensl 35 51 g Wl o0
5 olaS jobay (il CSlw (sl p3¥ ULl S92y Ll @ (nl p ogdle ams
3,5 ool il cS b sly 158l 5l 5l lgs oo

Aiile (Gl sl o axly jo Culyunl G (g ol Ol el IS Il o
i, bl i in ax o dalol o Lo (Fade) joi oo b s 12 cojlasl ¢S
58l 5 50 cpdaansl Gl 0,5 eubles Ll xS plo Jl58le 5 5o el c L Calises
Hlale o102l 0 g pes sl b9y dn o5 Sl (il slatg; sl Sl

(Tweening)  oLile -\

(Frame By Frame) o 8 4 oo ,8 (piceod! =¥

(Real Time Recording) owij Lo - ¥

Jad ezl U1, Lo gy L5T b, ol 51 S o b ool jsboas 457 ol (sl
DS ol e
‘Tweening «<CoS™ 4 piansil 35 -7

aS 00 aules casS ol couis b)) Slhmas o] jo A sole col el G 4y S
SlS 02,8 S (28 L Djg0 4 SCOTE 02 )3 ol ol 1o 05 (gl 457 porde
ol ol UL B s i Cardg WS so pusd @8lg 50 (gadS (o0 8 .ol (KeyFrame)

(=) JS) sl aigSe

N

KeyFrame

-1 JSs
Slts o1 50 g 0sS o ol | ol el SO e a5 by S0 &yl
0as Jans Jgl (oS 02,8 10 s (] (S o bl dims o, )T Jlie ylgicd)auns oo
&5 (Key Frame) (oo lS o ,8 od Col sl (LL B 15 5 e0gd g0 Jaa> ol sl UL G

Ol 0 9 a.aS adlalKey Frame G col el ;3500 slaps 13 51 S5 o leds 5T s 0 las 092

YA



aS gy ol 50 dles,S sloul ol el SG s o |y s b e [Key Frame
Iy adS 02 90 s slagedl 4y 1955 o oSl o Bg a0 TWeening L oLl 4
Iy A 0 y90 puo sl ¢ lacol Keyframe go b Ladd e 5 05l oo ,S055> &0
o 2 ((Size) ojlasl il Sleogas g5 g0 o p ogdle aS a5 ail ails az g
(Foreground Color) e iw S, (Blend) cosla i (Skew) o, Ll (Rotate)
&y oo o Tweening —iedl (o 5.5 1, (Background Color) e s S 4
WS 4z g ) Jle gl Lal Gl 0 I8 5 Gy, (nl b i o5
Y G a5 ool 5 o o olile el iy Sl el L) Jlie
WS b azas ol cunly Coons algS 4 axano
58 bl Jolye
VSRR S PP-XVRE S VPUE
NVt ‘) o‘yﬁJa w‘).o.w‘ S diseo YU o Ceoms M; o=y
258 Sl o calyd 2l o8 555 msle SIS Ll =Y
S 25 b ol o Key Frame oy 5 g, 99 51 S & ¥
Insert/ Key Frame (Ctrl+Alt+K) s 5 ,b 51 (&l
Insert Keyframe Lo 3 1>l 9 51 02,8 (59, ol SIS (o
S Jie ol Cons (mly 455 @ )01 w008 bl 1) sl Gugle SoSa -0
5 Lo (8l 1y 8y s 1535 15 (i o Alimle $Y JS 5 10 o glailon
b o ol el slol g lail (GoldS 13,8 9 (o Casly Jas S a5 WS

o - § !
Pl -

u“ = ﬁ——

n‘_ﬂlﬂﬂ‘.lﬂ.ﬁwmm i =

& 1% 1

Mﬂm -—*-

- e | ¥
Homo e g W { i

Keyframe (5,5 4ol oS &5 ililoo ppissanil Slosl $-¥ JSCi

ra



YU 5l Col el a5 3o wules WS |1 Score gl 4 oo JESIL |, ioles eiST-#
&S so S > (TemPo) ol e oo b ol @

1135 Comad (Swd O yg0d (G35 sl 8 (10,5 adlal 4y (55Ls o &5 1> (pdinend] jo S0

Olpls as cud KeyFrame & ga 1) &l s S095 & gods dilgi oo 95 plo

..\.‘.‘5‘5]0 ‘) 2D oolw J.’>‘).c W‘GSIS
BaS olo] diors po 1) Col el N
0,8 0 oS S50 e lpiil 4 ugle SoS a1 Colyl Cud adai s jo Y

(F-Y JSi) 09 aidlo &8 o o 00 ol Sl el 8 2,51 50 (ullS

B Stape (100%)

£aub nkd)

Cotlppal 92,5 S 43 by 4 S 42 el o] F-1 JSb

PR G psb (5l a5 Sl (uelS 8 90 41 5l Blao el SG bl (s i
WS (oo LN Cul el 5l oalgBds 02,8 30 )55 (geg0 g 01 S92y (Sul el 52 50

¥ b
CS o s yono (59, 2 a5 1)) Jlie ol sl « TweENING il 51 oolaswl b

BB S > (ST s (59 g2 S (0

VY



S5 ol o

s 008 S yo stage Lawg g YU oo dy polin jobody oo J13 e la g yo
AS 2 Galed o (P-F JSC0) 09 ol SO Jionie

" Stape (100%)

i 4y oin s Jy i $-F JSi

Sl Sl 9 9 -V -F-F

S S g, oS il 1y 8 Jle iuled el pudlss oo al> o (ol 5o
e | 5905 (o 5 oSl 15390 gl s el IS 5 el o]
J>1e ssbiie cpl 6l oS Jloel ol @1, (Blend) Sisenl § i 2 siile (s
RN ,ol.gu‘l Iy »5

QS Lol YU Ceows 4y dies jo 1) 5 (8 08,5 Gl 1) col pul Jgl (gadS 02 8 -
(220 plil s bax 0 1) Slol> Jas aulg oo Sift aas's SeS'4)

P S G S bl iz b ) s 00,5 SN p90 (G0lS 5 3T
o>,z gz |, Y8 sae Property Inspector o , >, b <ol ol I3l )ls— Rotate
(-0 JSB) 0uS o )ly celu sloay ie cya jo JolS 590 S ojlusl g s i

'



e 00 W o B

UERICE
e tim mla e[
w[w -fa |
[ - e
CLo bw B
FIFE R e "'-":-;r:'-
. [ |

7 b g s gl 53,5 e 50 S -

Oy s 00 1,8 dizeo (Vb jo 1 e b 00,8 Sl 1y ;ST oS vy 5T

- B o b

|
af= w[#
wfme 2w mles w[w
'I_'FI_'

-
Codlish i 5 YU Coow & Cylpun] 92,5 ble £-5 JSb

RS



5 5l 5elS o253 51 935 om lam Mo 45 joloilan 008 |yl 08, 0,55, iyles -
G ojlail 4 jis > G0 g @L?ub- Jol &8 o sl 0ol o] &S > EP 90 pgd
Sros 9 &S 2 (gt Sl o B pgo o 2 5 atlboe (420 Y7 2) (oS )90
@4z 3 V7 Sl lasly o cal Gl ol cnl JWdo 102 52 (o0 55 (woSae &30 VL
7S ol Cdlad i3z 5 S8 o e 0 85 Gl Ged ) aalsS i i Caans
b oo (B hai (e 2 b
Tweening Olouas —#-1-Y
SeS @ a5 (5,5bay el Tweening o ioad! S cya gledas slylo 525 ulo
aalod olml 5 (b 653 s28ly D90 @ 1) a0 50 S Wil e )5
5 odarasil Cam s (28 2 s i 4y Gl g0 (IS 2 DB 0 L e
olbled i az e QL Sl gl le 05 o)Lt (5 e ) by o lolais
i s2ese il 5 05 5 U tolly ol 31 (59055 (gt 41 Slophiss
DS el Jolye
S Bl aglos S iy 15 1, alloe ptead] 31 69y 52 45 gl el -
IS sllas o loygle ,olS b oS’ Llsesl |, Modify/Sprite/Tweening g 51 -Y

el 5L £-Y

Sprite Tweening

() Sharp Changes R

Ease-tne (] o %

Exse-Out: [T o «

Tweening olodhiss sl y9lxe ol $-V JSh

Ll e it

vy



Sleogds Jleel ol g5, 2 TWEEN Jos dunlgs o5 aS |, cioogas o TWeen iy jo-Y
I 3 Sl Cl o by 5F e o, iy jsbds S 1 Sl el

O |y olils e Lzl S5g3> CUrvature iz ,o 99290 oMl 35 ,b 51-¥
ol odls &S > (EXtreme) cwly coow a4y jodlwla> 0 a5 i opl a4 asS
bzl (wiS eS > (Linear) ¢ Coows 4y jo0dl az 2 (WuSe g yidon s (gLl
g s (b Cules 50 g fKeS e
oS o cebas o ls L3 Normal el b by j0 o)l ul (5,8 iy jobdy 4S5
el (rnd 1 (6 o5 355 0 (e Slop 5> ]
oo 9 Vb (i3 53 a5 02ty (l Galed i (25w 51 &5 52 s osaldio (gl i
S oolaswl oyl 108 0y o
@y Sgon |y Glopls ys aile i (6l e Sl g latl alsz oo 510
S Jls |, Continuous at Endpoints a5 S oy ;55050
il Sglaie gloo Sloe b ay ;5 90 (slyls (Cuse o) Speed iz -#
& g ($0le O ja0dr (GaulS 03 3 90 (o ol pwl &S > :Sharp Changes o

255 0 D ygo
Sgad g 05 O ye—ody (GO 1,8 90— ol il &5 >:Smooth Changes
S (o0 )90

oud Ol Slaos P i Jgo! -7V -F
Sleeos 8 5l (e 039uze Ll a5 ams oo 093 ()5 & ) OISl cal H955 0l 133l 5
5l oty Slomg) piemansl 93,5 samlive a5 jhailon b Lo, 15 Lty |y ol el S
Sleos B )3 39290 (rduedl Ladd Jlio (pl 3 pedlgdu 0iS jgai ot A5y Lol 4 o]
ol S polaie el sl 0 iy |y 9o 6 gl saels
299 GaulS 138 (55, 5 aiild a5 b | CHrl aeS's 00,5 SISy Jol (g0udS 0,8 -
1) Cal ol iz b S5 sl o 15 5910b) 09— Ll 00gazme cpl b autS SIS 35
(0 bl 5 03l 1,3 JUE Sy o a8
08guze Ui uuS SIS  Stage o i 4o 94250 Selected Frames Only asS's (gg, ,— -Y
g o0 Lo 8 JUI )0 () jow baz Clo (ol o gl LBl ais 50 lae 2
$-A S

V¥



> al

0 odo b e (o bk cw | Sckeiude bene &
. s el AT psla pk

<

144 3

Ry gz stiio sl 5 F-A S

QS s | gioled g Jld 1) LOOP 4eSs Jb> -Y

:(Frame by Frame) a 8 4 s 8 pinoni! —#-Y

LSy Sy jolS 0 ey iy Sl s s03p 9 IS S L o] (sl
Ly glasd i 5 JolS sloprinasl asilsi oo (B9, cnl SoS a0l walss slml (—toall
S rsad $o,ol8 cobo sl il gty Sl b (5,5 azen 6,61 35
.5 Coreldraw s Photoshop s> alizee sl )l38le 5 5l led oo s (og, o) 5L 06—
A.._S oolaul

ot 4 P (ool ) > o0 Y-
Syl sl o3 ol )9S uls 15810 5 50 008 s o2 el S 2l 6l
20,5 IMport jl3le 5 Loee o s 03,8 sl Lal33la 5 ol o 1) 5158590 (6 g
JUis " p s w2 B gy 4 el Sy Sl S | 5 ST e sl se (bl ]
Crtosil 5 830 (510,005 L Loy b (o> )
Cast )3 o jo Cay low 5 (43,5 8)lg =¥
Sy aislo bl jo ol el suplys o a5 Score sla JULS 51 ou 8 bl -Y
Shift aS's 0,5 Gl |, Cast memeber ,.Jgl) Cast [ ioodl sboes 8 bl -F
(35S SIS Cast memeber oy 51 (g9, g ails a5 1,
Modify / Cast to time L 8 sl,>1-0
Vb S o ae 3 1) o8 4 0 8 el o 3L &S] 6l
S A g

Yo



¥ ke
e isled el K cilizee > § dawgi | oo ag s &5 >

DS el Jolye
gl oS b -1 S Bl |y celu alize sldl> Photoshop s -)
(S 0pzd B SS ol cdl>

SELLYE
PP

-9 JSh -

I,Cast o,ox # U\ sloails a5 g sbds .aaS (xS plo o)lg 1) 00 i 0 pd sla B -Y
DS gy Y S sillas

F LY o led) 0SS ol Cast o iy jo | laails ads-Y

DS bl |y col sl SO ojlels JUIS 51 ol 00,8 -

Dgd Al Sl wl b oS |,>11, Modify 2> Castto time )l ,8 bgio 35 b 51-0
255 210 5 el 2,3 F Calpal nl (238 oy ol 35S on 030l in o5 shails
Loyl 0silgs co g ol oolol ool (9580 .5 o a5 10 0,8 S Cdl> 12 sl

Y,



G Gwsd S yg00 |y yT coas ploml Sldas 2 550 (6l ol i Lol c0sS e
odpline |y celw pgo Cl> dioro 10 wuS SCASTY o )laii 03,8 (59, ST S AsS

b o aalsl 7 B B el calizee Glpill> S 5 (et 4 5 05wl
Lol 2 sledsy 5 (S & asles oo caVl (Ls Caeyu ST.0S 150 | (el -

WS w3 VY ) Salpe il Jobo ST 2353 lsieas) Sulpeal Jsbo 0,5 il iz @
(055 oo 5o Sl jo sl 008 99 )95 plo
(Tempo) va cc pw ualS @
S 0,3 Clock ob b 1) isles =Y

(loop Film) wlé dil> Sl ! —#-Y

gas S Sz @bl G ) teenl S adlgi oo it (S ol v
aile) ausS solawl o1 5lai o3 a5 > ,o g ausS (6,lagSS 095 Cast AlbulS jo 1o
.(Flash ,s> lMovie clip

DS el Jol5e

S (b 1) 0g3 el Y

COPY) 4565 5 ol 3l g Pl cal el S5 -F

(paste) .oslowsy 1,1 Cast J& slaails 51 S ,0 -0

DS Aol T ws S o,ls 1, algsds oL Create Film Loop (slo gl ,olS )0 -#
(a3l oo Film Loop 1 5,8 s ob)

4 Score o 1yl ol el ccpionssl >1b 5 es Film Loop el Ll i, s

o yglos pol5 15 oS 50 Cast s slaails 5| Sy g5, i )T usle SaS
S ol olgsds a6 L 1,1 5 544 alls Create Film Loop

¥F Je

Filmloop & & g0ty mlacsl L3 al> 10,0 a5 |, Clock o iadl ponlgs o
oS 0,05 (plid 45 12)

DB sl J1 5

ubs o5 Background Transparent 4 1,1 InK ogl> g Gl 1) col !

WS Sy Cast o oy J slaails 5l (G oo a4 | iieendl Col ol

ol asS ol ol e, S sl 1, Film Clock b oo jalls slo,glme ,0l5™ 5o
Lgsl?ds‘bjmsawl_mcast)b?—\\ LJS_.udJLEAojaﬁs.iinrvud\.&l}A_izw)J
el ooy b el

ywyy



om.?leg/,,_gédlé)g S0 JSh

Jbe Olgiear 08 oolinul 093 ialed gl 55 Gdaedl Gl 5l ailsi oo (52T -F
aizeo 3)lg 1) s byl Wld dil> ] sloas 00, Bis | disro ;0 34290 ol
S iy et 5 95
P aS | (celw Sdl> £ 4 by e polad) ol Lol slops b i laisiazgs @
Sl al peldas > 15 S Bds wylos S 0,33 Cast o ey £ LY lodslw
Sl ool aisl polie

okd dile> Ologtis —F-1-) -
p3Y LB sl s s ] oladais 5| (B aily e ol adl> ol I ey
S Property Inspector ;o ss—>g0 Film Loop aiL; 5l g olsl 1) old adl> il
Ao oo lid |y aly pl P-VY S 0 5

Framing: (3)Crop (O)cale

I I-"'-‘--.._______hﬁh:- AT
s s o ([l B
i 1aga cHah gmty
Pl gy ok Cuynuy

Film Loop oleskis -1V i

YA



P2 i sk 45 adly e Scale g Crop 435 99 (1l (((su—nclB)
5o 1y pld adls o3lasl aes o o5l Loy 4y g cul Jlad ] Scale ay 35
SZsS D)ge 3 de S p |, Crop aziliz WS SesS Ly S5 amo
P phd dil> ol gl 5l (i (phed adl> g0 ,0l) B (S
O S8 oty aniFeo pl S F-IVY Sl jo ol aalgs ooy

..\...‘5‘50 ssalice ub

Framing

Ll Crop aSiley g 0l oo Jd 18 (0,8 iw jokay 4038 ]
o1y el adl> cod alads OB ojlul s ple 5 0l ales Jlad uuS

R O BUCKSLE %

Center

g Score o, slao LU 51 (S yo lao S pals j1,3 L oy 08 L
Lo o inailolon a4 55 1) louo old dil> caLw ol a4 ] el
[KW-RLIDSS YW [N CIPV SURRLIG AN - IT- EER KW WA FE SR g VLY
Jb (asS Jleé |, Loop 435 Sound a b 5 ,b 3l g olseil Cast o |,
Film ,3 352 g0 slawo (idu aile 0ilsi oo Audioasy ;3 0, Jlad 8 Lo

-3 95 Loop

Audio

W oo iy @3l jelay dis jo W8 ddl> ail Jl-’~9 4y ol “-’”L"’
Sgder Sy LSS b &jeo ol e (o

Loop

Framing slaais ;S 51 $-1V J<i

AR



Reverse sequence : piaond! <O 098  woekro —#-F
Oy gty sl JS el (el (ool 45T ol l (59, Gleyd onl 121 L
Ol ool (b & ST Gl e sloo )51 (S 95D o0 GhS esSns
@ e Glod )3 (wgSae O )yg0d Alolddly g dimo Cul) 4 &5 > Jls Glgreas ol
@B S oS Sy ead asle Giveddl il STAY Jlte) celw 08 o (ot 0 b o
Modify s 3l Reverse Sequence Lo 8 Jlas! b ¢pilbucn Jol ol ol juo iy

ol AL woSan O jgots |y el LS > oles oo
535 (b el Calel S (sl 1y 055 a2
S bl 1y el el JS =Y
A58 » |, Modify - Reverse sequense giws gie 31 =Y

(Recording time Real) ;00 ) tano <CisS - piwowd! —#-0
55 ol 4 dloe 00d) fand S5 > S5 slml (6l ,95S plo Al (sledy, Sl (S
SB gt 5Ll bl 51 o8 o apmles o oS Hai s )9 ol el 5l (o0 2 55, 1) w0 a5
Control sgie 51 g 00,5 S Cal sl 3l 328 59, el o0 JLo Olsrea amo
oyl G aS s Cadle g os—i Jled b usS SIS Real-time Recording 4 35 59,
§00,5 OS> 4y £g,5 ap .0S bl A@l?@a.fg_é)]a)mgasldﬂ @8 5 gl el
03,55 oy 1y wgle a5 Sloj b )15 ol 5 0uS o slow| Keyframe G ol el 03 3 ;0 5o

1 - l¢2

Sy el jlo )95 1 ool Cownl 51 TEMPO 0o ¢S 1> Ce s gy ol jo 145

Sysn bard Lad el oo 5 ool a1 9 il oo adlo

o b il s Jlab $-15 Y

b olows gl 1) o 28 50,5 bl gz oY Cuo s Lt ol b, Tempo
35 Lot gl pnsl (o 3 Job ol (SKae ol auplgses wylss 5 L s oS
S9) Syt Sy B oS o5 1) oy 15 @ 29,8 51 8 Sl fig (g 109
Sl il [§
Je
0uiS Lzl 1y 53 taled sl J> 0
AS ol saas iules )

V¥



S Import oles axees plsrsas |y pgad S Y

A8 olx! | Happy New Year . -Y

olas Stage ol 1,0l ojlasl g aums 1,8 Score o s V ojles JUIS o, ;s gas -F
ALl

Sl 0 PV Gilke ol adsl 5 g 0o 13 Y o)le i JUI (g, 1 520 -0
Bgi ol o,lg Stage z > 5l el 13155 canms 13 Stage

A4S o2 Background Transparent ss, |, oy 292> ogl> —F

55l 5 6fps il 1, (Tempo) cs oo =Y

I, Real time Recording 4. ;5 Control sgie 51 g lseil ]y e col sl Jgl oo 13 -A
Sz 1y 5558 plo g 0gd el Yoo ke JUIS ,US 10 K5, 50,8 0l codle oS Jlsd
#-\0 Ji,.u).xf f:y.d o) Lo

= AL A m

' Paiit | i Sy g Sraew

T e — —

$-10 Js<i

Wby m AT Job o ol &8 > sl oS Cnl (J)ge o cpl atdh oS

¥



e . A5 5
B QP c‘#dw)b ‘)U‘ ‘u)f‘)ul‘u”ﬂubuﬁ‘ \A.’LM))LSA LQ“-"‘L")L)-‘““

ALS ‘).?-‘ 9 o).::}f) \) &La.?—\\
(Trails) ;piwos! SLO, -#-7

Property Inspector o iy 5 b 510 ol sl S5l g 0 Trails a3 5l eolaw! b s

Q%S’JL’J? L adly ) 0,5 cud dizmo g9, o] S8 2 o o 1y Zalpl 1 Glgioe

20l G35 pl a0 Sl 4 il (pineil 6lls a5 (el () 43S
(=18 JS8) ilege (b aimo (55 a5 5550 alsl 5| (oS S 8 0

‘x‘:‘h“i‘h“iﬁﬁj AR x‘ -

-u-l-i—h-i-i-l
J.l-- l.lillill'il.ini.lJ.J.J
|| =
s[am ofm
ef[m oo wlem s
=@ al@m
“—\“1‘ W . kg Trorge ¥ WY
W omF ER G W, o
F-15 U<

¥y



ol g olmle asle sl loj 10 Culynl S (g 0l Ol s iorend]

0S8 A g 1) el ) ST A SST 4y Wilgh e 5935 ko

(Tweening) sl slops 8 SoS 4y -)

2 4 22 el =Y

( RealTime Recording) ous; las -Y

O—imod] SO (608 38 93 53 Cul el Slusgad s SeS 4 Tweening SusS 53
Do oo &3l

b plol 1y Tweening clalais olg o Modify = Sprite>Tweening o, oS4

Sl ,8 baad ols 5 o Stage o,y 40 35 >50 Selected Frames Only 4> d_wg &
Dged iy 1y el Ll

Dol 0258 4 0248 o] G e guad (o3l I e 0 Modify = Cast to time )lo,é L
5 o Jtl 1y Cal ol 3 s S () 29005 3 llo (il 3 3903

ol o155 bews dues! o)y o Control->Real-time Recording Lo ,8 SaS 4
WS (oo &Sy ogle b g 039 (el Dbl gy Gy oy () 2903

» Cast Jitue gae S ©jgon |y odd (Shb 8 5] pisedl S5 0255 (el ok adls
S Film Loop sl (gly .0 aalgs o]yl slass jials el a8 amd o )8 )57 L)
A8 S Cast 5l JB Joko <SG 9p0 @ 1) gl g obesl 1yl 590 (laco] yol conl

2,5 weSae Iy cpduess! S lg5 0 Modify (5400 5l Reverse Sequence (b, Jlosl b

S o e 5o |y Col el SlaS aes o |y Gl cpl Lads 4 (TraIS) (piccondl gL,
S S Ao (55,5 Sal ]

Y FY



Learn In English

Using film loops

A film loop is an animated sequence that you can use like a single cast mem-
ber. For example, to create an animation of a bird flying across the Stage, you can
create a film loop of the sequence of cast members that shows the bird flapping its
wings. Instead of using the frame-by-frame technique, create a sprite containing
only the film loop and then animate it across as many frames as you need. When
you run the animation, the bird flaps its wings and at the same time moves across
the Stage.

You can also use film loops to consolidate Score data. Film loops are especial-
ly helpful when you want to reduce the number of sprite channels you are using.
You can combine several Score channels into a film loop in a single channel.
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a) animated sequence that you can use like a single cast member
b) reduce the number of sprite channels you are using
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Learn In English

Some Events in the Behavior inspector:

BeginSprite contains statements that run when the playback head moves to
a frame that contains a sprite that was not previously encountered.

End Sprite contains the statements that run when the playback head leaves
a sprite and goes to a frame in which the sprite does not exist.

RightMouseUp indicates that the right mouse button was released. (On
the Mac, Director treats a Control-click the same as a right mouse click on a
Windows system.)

RightMouseDown indicates that the right mouse button was clicked.

MouseEnter indicates that the pointer entered a sprite’s region.

MouseLeave indicates that the pointer exited a sprite’s region.

MouseWithin indicates that the pointer is within the sprite’s region.

KeyUp indicates that a key was released in a text or field sprite.

KeyDown indicates that a key was pressed in a text or field sprite.
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On Sum x,y.
T=x+y
End
On Mouseup me
sum(2,3)
Member(“Disp”). Text=String( T )
End
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On startMovie

member(“Disp”).text =" Start “
End

On stopMovie
member(“Disp”).text =" End
End

oazeds g Start & le puled glyzl 4aSs (69, SIS L oS s 1) ioled y9:ST1-Y
Dgd o b e yae W END O)le ol alad
Obey® 5l ookl g pld Con )l (9,0 4 SUM Juce JESI b o )lo duad al> o () o =Y
mufow;_gluj)o “ )JMU.J ‘)JLurg.uSLg)Lwd.u.Q;‘)wLu‘Return
IS ol o Sl g0 ol Slgiome cdl> cpl jo oo Jlail old s Sl g0

PN P RUII O RLA FPVE

On Sum (x,y)
T=x+y
Return T
End
On startMovie
member(“Disp”).text="Start”
End

On stopMovie
member(“Disp”).text="End”

End
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Z=sum(2,3)
Member(“Disp”). Text=String(Z)
End
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Mylist=[ "a","b","c"]
Put Mylist[1] = "a"
Put Mylist[2] = "b"
Put Mylist[3] > "c"
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Data=[ 22.,4,10,1]
Data.Sort()
Put Data
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List Name.Add(Data)
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Computer =[ " Main borad","CPU","RAM"]
Computer.Add("Graphic")

Put Computer
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Put Number
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on exitframe me
go the frame

End

Syl Dy Cannd iy y23 Cagz olid o Sl
Global ShapeList
on StartMovie
ShapeList =[“Rectangle”,"Circle”,"Trianglae”]
End

el IS5 L3,

global shapelist
On mouseup me
member(“namel”).Text= shapelist[1]
End
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global shapelist
on mouseup me
member(“name2”).Text= shapelist[2]
End

edte IS5 L3,
global shapelist
on mouseup me
member(“name3”).Text = shapelist[3]
End
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Reset 4.5 L3
on mouseUp me
member(“Namel”).Text ="
member(“Name2”).Text ="
member(“Name3”).Text =""
End
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If n=12 then count=count+1
¥ Jle
If n>=12 then
Count=count+1
Else

Sprite (“result”) . Member . text = “Invalid Number”
End IF
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Global n
On startMovie
n=0
end
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Global n
on exitFrame me
n=n+1
if n<3 then
go frame 1
else
go the frame
end if
End
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on Mouseup me
Repeat with i=1 downto 5
put i
end repeat
end
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on Mouseup me

Repeat with i=1 to 5
put i

end repeat
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Blend 4.5 L3,
On MouseUp me
Repeat With i=1to 4
Sprite(i).Blend=50
End Repeat
End

Reset aoSs L3,
On MouseUp me
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Repeat With i=1 to 4
Sprite(i).Blend=100
End Repeat

End
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On Mouseup me
i=1
Repeat while i<=5

Put i
End Repeat

End
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Puti
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End
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On mouseUp me
member(“Namel”). Text=""
member(“Name2”).Text=""
member(“Name3”). Text=""
end

On SetText

member(“Title”).text="Start”

End

slayg, sly Event Handler S sl ls cou ,Sul ol 0uS oo alasde a5 5 lailes
00,5 S cwe gl a5 ail o SetText sLa, Custom Handler S, 3 mouseup
59 ol 0dld Algl Lo gac SO 4 B0 Hlade Sy (s090 9 (sike pais dw Ol
S o leuds Sl sl (59,5 )8 il oY MoOUSE UP Slay gy paw slzl cyz sole cl>
S L mouse up plig b Ko Ojledy 050 Lol Lo (o SU Joe b aiS SIS

V0



203 o Kool G2l 5l lsiien ST 85 el ls Jaia ool 2 sl ) 5,50 Al
9,5 Caom Sl (4 mouse up pley Jlo )l 4y pladl

Sol a5 oS eola_ul SendAllSprites() 5 SendSprite() sl 31 jgkaa ol sl
Loyl 4218 2, plicy S sl et 505 5 Sl ol S 4 pliy S Sl s
Sl 5,18

soolawl Glf r’)-é
SendSprite(spriteNameOrNum, event {, args})

SendAllSprites(spriteNameOrNum, event {, args})
1o 9o U"‘ Lng)...AbL’ La Ls’l“""’—‘
oyl JUIS 0,les b ol el oL :Sprite Name ORNum
D¢ oolaiwl # codle 5l el 23Y o1 51 L8 a5 slayg, oL Event
b s 3 el 0929 ©j90,8 (g 03g gLl a5 Jase sLs zl 1 ATGS
09 5SS i i 4 gl polie
YU 0 oa ,SSMOUseUp olayg, poe sla! cus 598 Dlonoss 4 axgi b ol il
Sy 60 MESSAPE 0,20 b Josis G p0 1) 3 ole,d conl S
SendSprite (1,#mouseup)

109 |).?-| 2) uLo).‘B Sl ngls Set Text Gm )J..\...Cb 6‘)'?" S o).>‘-§ll4' 9
SendSprite (1,#SetText)

YV&



Al 40X

g g0 a15Lh Lingo plias j935 pls ((cumgh S Sl ) (omgs sl ()

Jee g 00l g (oaisS ool ) dlayg, G y,0 45 ¢S] Ol jgiws 5l Slacgazme 4
D9 oo 4385 Cap Sl (i oo plxil |y sol>
1l il 650U WMl

W Hlake S ousS adgs a5 Ol jle tKeyUp wisle laolay g, ¢True ausle Lyl
aiusS o Handler T 4y jaisee ,5bay a5 Event Handler a5 slayg, poe €V -X o sl
P gy S LS 53 8 el g Sl S 958 (sl gl Sl garma 5
A gloa g5, ©lals (Keywords) oS’ wlelS wg—i o |21 MouseUp ol
o> slesodle (Operators) s Slos - end jgiws aile dliwd  Jose gine syl a5
oz Klas anle ams oo plol oo wiz b 5 59, 2 |, caiin Joc a5 an
599,95 srools (5,1, sols Jas aS aiiwa sloolel (slozs Sl (Functions) alss «(+)
Al 45 0o 110 Ko 1) X3 a5 SOI(X) asls aiile cis oo ploxl (2 2l ,b)
Ol 09y® 90 85 (B Gk Sl el 03 (5318 g a5 Sl (nl bl
Loace calas as 1) ool 51  olite Slail )la5 oo Lo Tal,ls oS a4 15,5 pladl cos s Ly ya5
SSolo a5 s gloals 9,5, SledS” (Properties) Sloogas g0 Jlow,l s Sl
Width aisle il o g0 geae S b Sl ol SO aiile s 8 S Dglite la S5
Ll 1) LT wlgs o 5958 1o a5 it rmo IS & ool ,3 (Statements) ol oo
Wy n ool polie (0.5 59,40 9 5, Ca b e 5190 "menu” sisle wiS
5 6 eSS BB it 40 4 WSl oo £5 @0 e (0l &Bly s Cennd - F =1 wiile
n=[25,34,77] asle cusl ool

198l yol,5 b o L

Sprite(1) 5 SPRITE(L) & lie 55 1 mas ol SirsS b 553 By 4 552
b Jal Iy potie o

oolawl v 4y otz (e ST Jlail s cuodle g0 3l Glresgi g sl
"t

il Dglaie 0 )15 g0 slylo 5l 5,

Febly et S e 9 @l 50 )

Suglgl s Sz (2L, Shile oY

g on 0olainl (glakads ol 5 5l e ol S 5l patrine dio b Conols 4y o s (sl
Camol> S5 b Ll 10 g0y ,SToz gz atais G o 5 o pb lal jol 3 sl o

YV



put member(1).text aile oS o0 ,53 1, (Method) o L (property)

Db oo LT el sanlive § 65d Ol jgiws ol S cmwbie Il Message o

Hlas,le a8 oo 052y Con Sl £55 )z )5S nls o

(,l3,) Behavior -\

(pked < ,Sl) Movie Script -Y

(g6 o ,Sul) Cast Member Script -Y

(Vg cos ,Sl) Parent Script -

st b au g |y 095 5L 9,90 (slocis ,Swl 0ilgs oo SCHIPE o,y SaS 4
S Gl g

A plos o i g 035 (oo yiie ()T 95y Jake Sy (99,0 jeitie S 5]
>l o gseript o o bas gl 10 (6l s (sl pxio Lol 0 gy walgz i LB
idlige s BB 5 el e )0 5 Wil oo o Global

5wl 5Sad o 0szse sla,Shes S5 5bay

b,y gl Nles -)

Slawlie sla Klos -Y

sihie o Slae -Y

slas, sla Klos ¥

ly olasy poe S ol 55kl v coi 54 oS s s oS LIS End 5 On

plasle a8 0o 0525 1555 nls )0 ply g6 50 L5 S0

(System Messages) wiwwws sleols -

(Custom Messages) oaxi bl =Y

39S plo old s jo ol Jais b jglateds old Con Sl L, Movie Script
StartMovie ails g, o0 54

w5 2] Q] Sl Olhgiws b jgiws sl )5, by s STIf b oleg ye
oS aslielse Jols by oSl Ko w058 g0 |21 (6 5 g il 3 by amiliz
Al dwles |zl else 5l as olygiws & jae ol 0

aal>-Y Repeatwith i leds 1,85 aal> - 5la s Le Lingo ;o Lodal> gly il
Repeat while L &

L gl g lalls cde 0 5 1oy sl p ool slls Debugger Window o , >,
D 5l 3550 55T a5 plaJase 12l Wl se eiren Caleinn Sl b
asbe bl plo &l cools ioled alasd 12 j0 1) b xie jlade o (SKIP) oS (5,5 5l>

YA



£

S Hlis ) syl
LSS aly plg S oles oo SendAllSprites() 4 SendSprite() slsais a—wga

Learn in English

Global variables in Lingo

In Lingo, variables are considered local by default, and you do not need to
precede the variable name with any keyword. To declare a global variable, you
must precede the variable with the keyword global.

If you declare a global variable at the top of a script and before any handlers,
the variable is available to all handlers in that specific script. If you declare a
global variable within a handler, the variable is available only to that handler;
however, if you declare a global variable with the same name within two separate
handlers, an update to the variable’s value in one handler will also be reflected in
the variable in the other handler.
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Learn in English

Using default Publish settings

To create Shockwave content, use the File > Publish command. The default
setting creates a Projector file with Preview enabled.

Select File > Publish.

Save your movie if prompted to do so.

Director creates and automatically starts a Projector version of your movie.

If your movie needs Xtra extensions that fall beyond the range of the default
publish settings, (for example, Windows Media) you will be prompted to add
them.
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Learn in English

Synchronizing media

To pause the playhead until a specified cue point in a sound or digital video
is reached, use the Wait For Cue Point option in the Tempo dialog box. You can
also use this method to wait for the end of the sound or digital video, even if it
has no cue points. Cue points can also be used to trigger events that scripts can
interpret

For example, you can use cue points to make text appear in time with nar-
ration. First, use a program such as Sony SoundForge to place cue points in the
sound file that correspond to the times when you want the text to appear on Stage.
In Director, use the Tempo dialog box to pause the playhead at the frame where
the corresponding text appears until the voice-over reaches the proper cue point.
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13-Wait For Cue Point option is used to:
a) Pause the playhead until a specified cue point in a sound is reached.
b) make text appear in time with narration.
¢) wait for the end of the sound or digital video, even if it has no cue points.
d) a, b And c.
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voiceSpeak()

Usage

- - Lingo syntax

voiceSpeak(«string»)

Description

Command; causes the specified string to be spoken by the text- to- speech engine.
When this command is used, any speech currently in progress is interrupted by
the new string.

Parameters

string Required. The string to be spoken by the text- to- speech engine.
Example

This statement causes the text- to- speech engine to speak the string “Welcome
to Shockwave”:

voiceSpeak(“Welcome to Shockwave”)
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Else
member(“Disp”). text=""Outside”
End If
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sp=RollOver()

put sp
end
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Sprite(1). Loc=_Mouse. MouseLoc

End
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on keyup

put _key. key

end
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on keyup

put _key. key

put _key. KeyCode

end
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on keyDown
if (_key. ControlDown and _key. key = “p” ) then
member( “Disp” ). text="Ctrl +p is pressed”
end if
if (_key. ShiftDown and _key. key = “q” ) then
member( “Disp™ ). text="Shift +q is pressed”
end if
if (_key. ControlDown and _key. key = “x”" ) then
halt()
end if

end
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Learn in English

Finding mouse pointer locations with Lingo

When working in Director, you sometimes need to determine where the mouse
pointer is on the Stage.

Use the mouseH and mouseV properties. For more information about these
properties, see the Scripting Reference topics in the Director Help Panel.

The mouseV property returns the distance, in pixels, between the mouse point-
er and the left corner of the Stage. The mouseH property returns the distance, in
pixels, between the mouse pointer and the top of the Stage.
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Learn in English

Playing digital video Direct To Stage

Director can play digital video by using a feature called Direct To Stage (DTS).
Direct To Stage lets video drivers installed on the computer completely control
the video playback.

Note: The Direct To Stage feature cannot be used with DVD or RealMedia
digital video because DVD is always Direct To Stage and RealMedia is always
non- Direct To Stage.

Direct To Stage often provides the best performance from a digital video, but
it has the following disadvantages:

The digital video always appears in front of all other sprites on the Stage, no
matter which channel contains the sprite.

Ink effects do not work, so it is difficult to conceal the video’s bounding rec-
tangle with Background Transparent ink.
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